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The Altera® Nios® II processor is a soft processor that supports all Altera SoC and FPGA families. This
document describes how to boot a Nios II processor from Altera EPCQ flash memory (EPCQx1,
EPCQx4) using an Altera serial flash controller. The Altera Serial Flash Controller supports configuring
and programming of EPCQx4, EPCQx1 and EPCS flash in FPGA design for Altera Arria® V, Arria 10,
Cyclone V and Stratix® V devices.

Prerequisites

You are required to have knowledge in instantiating and developing a system with a Nios II processor.
Altera recommends that you go through the online tutorials and training materials provided on Altera's
website before using this application note.

Related Information

o AN 717: Nios II Gen 2 Hardware Development Tutorial

Refer to this document for a step-by-step procedure to build a Nios IT Gen 2 soft core processor
system.

o Embedded Peripherals IP User Guide

Refer to this document for more information about the Altera serial flash controller.
o Quad-Serial Configuration (EPCQ) Devices Datasheet

Refer to this document for more information about quad-serial (EPCQ) devices.

Definitions
The following table defines the acronyms in this application note:

Table 1: AN 736 Acronym Definitions

ACDS Altera Complete Design Suite
API Application Programming Interface
CFI Compact Flash Interface
EPCQ Altera Quad SPI flash device
HAL Hardware Abstraction Layer
HEX Hexadecimal file: this is an ASCII text file with the extension
of .hex. It stores the initial memory values for a memory block.
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I/0 Input/Output
Memcpy Memory copy
OCRAM On-chip RAM
RAM Random Access Memory
SBT Software Build Tools
SoC System on a Chip
SOF SRAM Object Files
UFM User Flash Memory
XiP Execute in Place

Description of the Altera Serial Flash Controller

The Altera Serial Flash Controller with Avalon interface allows Nios II processor systems to access Altera
EPCQ flash memory, which supports standard, quad and single- or dual-I/O mode. The Nios II processor
SBT supports the Nios II booting from the Altera Serial Flash Controller. In addition, a Nios IT hardware
abstraction layer (HAL) driver is available for the Altera Serial Flash Controller that allows an application
to read, write, or erase flash.

Scenarios for Booting Nios Il from EPCQ Flash

Booting a Nios II processor from an EPCQ flash has a similar flow to booting a Nios II processor from a
CFI flash.

The Nios II processor supports the following two boot options using EPCQ flash:

» The Nios II processor application executes in place from EPCQ flash.
o The Nios II processor application is copied from EPCQ flash to RAM using a boot copier.

Table 2: Summary of Nios Il Processor Boot Options Using EPCQ Flash

Boot Option Application Code Application Run-time
Stored Location Location

Nios II processor EPCQ EPCQ (XIP) + Using al t _| oad() function
application executes in OCRAM (for writable
place from EPCQ flash data sections)
Nios II processor EPCQ OCRAM/ External Using a memcpy-based boot
application is copied RAM copier
from EPCQ flash to
RAM using boot copier

Nios Il Processor Application Execute-In-Place from EPCQ Flash

The execute-in-place option is suitable for Nios II processor applications which require limited on-chip
memory usage.
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The al t _| oad() function operates as a mini boot copier which initializes and copies only the writable
memory sections to on-chip RAM (OCRAM). The code section (.text), which is a read-only section,
remains in the Altera EPCQ flash memory region. Retaining the read-only section in EPCQ helps to
minimize RAM use, but may limit the code execution performance. The Nios II processor application is
programmed into the EPCQ flash.

The Nios II processor reset vector points to the EPCQ flash to allow code execution after the system
resets. If you are debugging the application using the source-level debugger, you must use a hardware
breakpoint because the EPCQ cannot efficiently support random memory access.

Nios Il Processor Application Copied from EPCQ Flash to RAM

You can use a boot copier to copy the Nios II application from EPCQ flash to RAM when multiple
iterations of application software development and high system performance are required. Altera
recommends this solution for Nios II processor booting from Altera Serial flash (EPCQ).

The Nios II SBT tool automatically adds the Nios II processor memcpy-based boot copier to the system
when the executable file (.elf) is converted to the memory initialization file (.hex). The boot copier is
located at the base address of the HEX data, followed by the application.

For this boot option, the Nios II processor starts executing the boot copier software upon system reset
which copies the application from the EPCQ to the internal or external RAM. Once this completes, the
Nios II processor transfers the program control over to the application.

Figure 1: EPCQ Flash Layout When Using Boot Copier

In this figure, the size of the FPGA image (*.sof) is estimated to be less than 0x01E00000. Customer data
(*.hex) is set to start at address 0x01E000000 and the size of the *.hex file is assumed to be 0x0000E400.

0x01EQE400
Customer Data (*.hex)

Application Code

Boot Copier

0x01E00000

FPGA Image (*.sof)

0x00000000
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Nios Il Processor Configuration and Boot Flow

This section highlights the design, configuration and BSP settings for the supported boot scenarios
mentioned in this document.

Figure 2: Configuration and Booting Flow
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Steps to Build a Bootable System

The following sections describe a step-by-step method for building a bootable system for a:

 Nios II processor application executing in place from EPCQ flash.
 Nios II processor application copied from EPCQ flash to RAM using a boot copier.

Design

1. Create your Nios II processor project using Quartus II and Qsys.

2. Add the Altera Serial Flash Controller IP to your Qsys system. Refer to the diagram below for the IP
connection in Qsys.

Figure 3: Altera Serial Flash Controller IP Connections in Qsys

1= svstem Contemts £ o
System: nios2_jtag_system
|| Use Connections Name Description Export Clock Base | End IRQ
-‘-H ) EQ nios2_gqsys_0 Mios Il Pracessor
clk Clock Input ck_0
reset Feset Input [clk]
i data_master Avalon Memory Mapped Master [cik]
—— Instruction_master Avalon Memory Mapped Master [cik]
el g Interrupt Receiver [cik] IRD O IRO 31
— dabug_reset_request Reset Output [clk] |
debug._mem_slave Avalon Memorny Mapped Slave [cik] D001 _1000 00001 1711
custom_instruction_master Custom Instruction Master
v B0 epca_contraller_0 Atera Serial Flash Controller
clock_sink Clock Input k.0
reset Reset Input [clock_sink)
avl_csr Avalon Memory Mapped Slave [tlock sink] Ox0100_0000
| al_menm emory Mapped Slave [clock_sink Ix0200_0000 000 f
— Interrupt_sender Interrupt Sender |clock_sink]

Note: The maximum input clock for Altera Serial Flash Controller IP is 25 MHz. The input clock
must not exceed this maximum value.

Configuration and Compilation

To proceed with configuration and compilation, you must double-click on the Nios II Processor row in
the System Contents window in Qsys to open the Nios II processor Parameters window.

From here, proceed to the "Reset and Vector Settings" section that is applicable to your boot method.

Reset and Exception Vector Settings for Nios Il Execute-In-Place Method

1. Under Reset Vector in the Vectors tab, select EPCQ (epcq_controller_0.avl_mem) in the Reset
vector memory drop-down menu and type the reset vector offset in the Reset vector offset entry box.
The reset vector must be the base address of your application. In this example, it is 0x01E00000.

Note: Your *.sof image size influences your reset vector offset configuration. The reset vector offset is
the start address of the .hex file in EPCQ flash and it must point to a location after the *.sof
image. You can determine the minimum reset vector offset by using the following equation:

minimum reset vector offset= (.sof image start address + .sof image size) in HEX
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For example, if your *.sof image starts at address 0x0 and is 512 KB in size, then the minimum
reset vector offset location you can select is 0x0080000. If the *.sof image space and the reset
vector offset location overlap, Quartus® Prime software displays an overlap error.

2. Under Exception Vector, you may select EPCQ (epcq_controller_0.avl_mem) or OCRAM in the
Exception vector memory drop-down menu. In this example, 0x20 is listed for the Exception vector
offset entry.

Note: When executing-in-place, the Nios II processor boots and runs directly from EPCQ flash,
without copying any code at boot time. Because the Nios II begins executing at the reset address
in this case, exception vectors must be located at a nonzero exception vector offset to allow for
instructions between the reset vector and the base of the exception vectors. Thus, you must
include an exception vector offset when the reset vector and the exception vector point to the
same memory and no boot copier is present.

Note: Altera recommends setting the exception vector to OCRAM to make the interrupt processing
faster.

Figure 4: Exception Vector Settings in Qsys

Address Map £ f@Parameters &3
System: nios2_jitag_system  Path: nios2 _gsys_0

Nios Il Processor
altera_nios2_gen2

[ Main | Vectors | Caches and Memory Interfaces Arithmetic Instructions | MMU and MPU Settings | |JTAG Debug | Adwvanced Features |
I~ Reset Vector B

Reset vector memory. lepcg_controller_0.avi_mem hd

Reset vector offset: .0;:01900000 ] o

Reset vector: 0x03e00000

~ Exception Vector -

Exception vector memory. 'c':ncmp_memurvz_l.sl -v.

Exception vector offset: :IL‘)H_OKSOOOQN B o

Exception vector 0x00030020

3. Click Finish. You will return to the Qsys System Contents tab.
4. Double-click on the Altera Serial Flash Controller IP to open the Altera Serial Flash Controller
Parameter editor.

5. Select the Configuration device type based on your hardware design and choose the desired I/O
mode.

6. Close the Parameter Editor and return to the Qsys System Contents tab.
7. Click Generate HDL to generate your Qsys design.
8. Compile your design in Quartus Prime software.

Reset and Exception Vector Settings for Nios Il Boot Copier Method

1. Under Reset Vector in the Vectors tab, select EPCQ (epcq_controller_0.avl_mem) in the Reset
vector memory drop-down menu and type the reset vector offset in the Reset vector offset entry box.
The reset vector must be the starting address of your application. In this example, it is 0x01E00000.
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Note: Your *.sof image size influences your reset vector offset configuration. The reset vector offset is
the start address of the .hex file in EPCQ flash and it must point to a location after the *.sof
image. You can determine the minimum reset vector offset by using the following equation:

minimum reset vector offset= (.sof image start address + .sof image size) in HEX

For example, if your *.sof image starts at address 0x0 and is 512 KB in size, then the minimum
reset vector offset location you can select is 0x0080000. If the *.sof image space and the reset
vector offset location overlap, Quartus Prime software displays an overlap error.

2. Under Exception Vector, select OCRAM/External RAM in the Exception vector memory drop-
down menu. In this example, 0x20 is listed for the Exception vector offset entry.

3. Click Finish. You will return to the Qsys System Contents tab.

4. Double-click on the Altera Serial Flash Controller IP to open the Altera Serial Flash Controller
Parameter editor.

5. Select the Configuration device type based on your hardware design and choose the desired I/O
mode. Close the Parameter Editor and return to the Qsys System Contents tab.

6. Click Generate HDL to generate your Qsys design.
7. Compile your design in the Quartus Prime software.
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BSP Editor Settings

1. Open the Nios II SBT tool and create the Nios II processor HAL BSP based on the .sopinfo created
from Qsys generation.

2. Right-click on the BSP that you have created and select Nios II > BSP Editor.

3. Configure the Settings.Advanced.hal.linker and the Linker Section mappings in the BSP Editor
based on your boot options. Refer to the table below.

Table 3: BSP Editor Mappings

BSP Editor: Linker Script Settings.Advanced.hal.linker

Nios IT processor applica- |, get text Linker Section to | If the exception vector is set to OCRAM,

tion executes in place from EPCQ (epcq_controller_0_ | enable the following settings in

EPCQ flash avl_mem) Settings.Advanced.hal.linker:

o Set other Linker Sections
(.heap, .rwdata, .rodata, .bs
s, .stack) to OCRAM

o allow_code_at_reset

« enable alt load

o enable_alt load_copy_rodata

o enable_alt_load_copy_rwdata

« enable_alt_load_copy_exceptions

If the exception vector is set to EPCQ,
enable the following settings in
Settings.Advanced.hal.linker:

o allow_code_at_reset

« enable alt load

o enable_alt load_copy_rodata
o enable_alt_load_copy_rwdata

Nios II processor applica- | Make sure all Linker Sections | Make sure all settings are left unchecked.
tion is copied from EPCQ | are set to OCRAM/External
flash to RAM using boot | RAM.

copier
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BSP Editor Settings

Figure 5: Settings.Advanced.hal.linker for Execute-In-Place Method if Exception Vector is Set to
OCRAM

Nios Il BSP Editor - settings.bsp (on pg-iccf0295)

File Edit
[ Main | Software Packages

Tools Help

| Drivers | Linker Script | Enable File Ceneration | Target BSP Directory |

SOPC Information file:
CPU name:
Operating system:
BSPtarget directory:

.f.fniosZ_jtag_system sopcinfo
nios2_qsys_0

Ahera HAL Version:

fdatafmmtanfepcq_prog_quad_cvsoc_modified_shiva/software fhelloWorld_modified_bsp

Patimker
[¥] allow_code_at_reset
Iv] enable_al_load
[¥] enable_alt_load_copy_rodata
[¥] enable_alt_load_copy_rwdata

- - - - -
¢ make ]
bsp_cflags_debug
bsp_cflags_optimization
¢ Achvanced
¢ hal

miax_file_descriptors
enable_instruction_related_exceptions_ap
log_port
enable_exit E
enable_clean_exit = E
enable_runtime_stack_checking i
enahle_c_plus_plus
enable_lightweight _dewvice_driver_api
enable_mul_div_emulation
enable_sopc_sysid_check
custom_newlib_flags
log_flags

o= linker

o make

[¥] enable_alt_load_copy_exceptions

]

Nios Il BSP Editor - settings.bsp (on pg-iccf0295)

File Edit Tools Help

{ Main | Software Packages i' Drivers t Linker Script 1 Enable File Generation [’ Target BSP Directory |

SOPC Information file:
CPU name:
Operating system;

of e fnios2_jtag_system.sopcinfo
nios2_qsys_0
Altera HAL

9 make
bsp_cflags_debug
bsp_cflags_optimization
¢ Advanced
¢ hal
max_file_descriptors

lag_port
enable_exit
enable_clean_exit

enable_c_plus_plus

enable_mul_div_emulation
enable_sopc_sysid_check
custom_newlib_flags
log_flags

o= linker

- make

enable_runtime_stack_checking

enable_instruction_related _exceptions_ap

enable_lightweight device_driver_api

BSPtarget directory: fdata/mmtan/epcq_prog_quad_cvsoc_modified_shiva/software/helloWorld_modified_bsp

14| hal..ll.nkér : T
I¥] allow_code_at_reset

[¥] enable_alt_load

[¥] enable_alt_load_copy_rodata

[¥] enable_alt_load_copy._rwdata
[]lenable_alt_load_copy._exceptions

[4]

4 ]

[ ]

Nios Il Processor Booting From Altera Serial Flash (EPCQ)

D Send Feedback

Altera Corporation


mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Nios%20II%20Processor%20Booting%20From%20Altera%20Serial%20Flash%20(EPCQ)%20(AN-736%202016.05.20)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

AN-736

10 BSP Editor Settings 2016.05.20

Figure 7: Settings.Advanced.hal Linker for Boot Copier Method

Nios Il BSP Editor - settings.bsp (on pg-iccf0295) = B

File Edit Tools Help

(“Main | Software Packages | Drivers | Linker Script | Enable File Generation | Target BSP Directory |

SOPC Information file:
CPU name:

f.fnlos2_jtag_system.sopcinfo

nios2_gsys_0

Altera HAL ersion: |

Jdatafmmtan/epcq_prog_quad_cvsoc_modified_shivafsoftware fhellovorld_m odified_bsp

Operating system:

BSPtarget directory:

L L= ¥ LU e U 1= L] A = L L=
¢ make
bsp_cflags_debug
bsp_cflags_optimization
9 Adhvanced
¢ hal

max _file_descriptors
enable_instruction_related_excegtions_a
log_port
enahle_exit
enable_clean_exit w E
enable_runtime_stack_checking
enable_c_plus_plus
enable_lightweight_device_driver_api
enable_mul_div_emulation
enable_sopc_sysid_check
custom_newlib_flags
log_flags

o |inker

¢ make

Taliinker :
[] allow_code_at_reset

[] enable_an_load

[] enable_alt_load_copy_rodata
[Jlenable_an_load_copy_rwdata

[] enable_an_load_copy_exceptions

Figure 8: Linker Section Mappings for Execute-In-Place Method

- Nios Il BSP Editor - settings.bsp (on pg-lccf0295)
File Edit
(" Main | Software Packages I Drivers [ Linker Script [’Enable File Ceneratian ' Target BSP Directory |

Tools Help

Linker Section Mappings

Linker Section Name a Linker Region Name Memory Device Name Add... ]
. bss onchip_memory2_1 onchip_memory2_1 Remove... |
i EHT e ESE'T - EF“E?—E\DM r‘fﬂll er_0_avl_mes Restore Defaults.., ]
. BXCeprions onchip_memory2_1 enchip_memory2_1
. heap onchip_memory2_1 onchip_memory2_1
. rodata onchip_memory2_1 onchip_memory2_1
. rwdata onchip_memory2_1 onchip_memory2_1
.stack onchip_memory2_1 onchip_memory2_1
.Text | lenca_controlier_0_avi_sen |epca_controtier_o_avi_nea

Linker Memory Regions

Linker Region Name Address Range « Memory Device Name Size (bytes) | Offset (bytes) | Add.. ]
epcg_controller_O_avl_mes O0x03E00020 - OxO3IFFFFFF |epcg_controller_O_av]_men 2097120 31457312
reset | OX03EQ0000 - Ox03E0001F |eucq_contr01ler_0_av1 —men 32| 31457280 Restore Defaults J
epco_controller_O_avl_mem BEFORE_RESET | Ox02000000 - OxO3DFFFFF |epca_controller_O_avl_men 31457280 o
onchip_nemory2_1 0X00030020 - OX0003FFFF |onchip_nemory2_1 £5504| Y
onchip_memory2_1_BEFORE_EXCEPTION 000030000 = OxO003001F lonchip_memory2_1 32| ol Add Memory Device... |

mory

Memory Usage... |
Memary Map... ]

Crayed out entries are automatically created at generate time. They are not editable or persisted in the BSP settings file,
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Figure 9: Linker Section Mappings for Boot Copier Method

Nios Il BSP Editor - settings.bsp (on pg-iccfD295)

File Edit Tools Help

[“Main | Software Packages | Drivers | LinkerScript | Enable File Generation |  Target BSP Directory |

Linker Section Mappings

| Linker Section Name & | Linker Region Mame I Memory Device Name I Add... I|
.bss onchip_memory2_1 nchip_memory2_1 | Remove.., |
£ erl’f r}’v = N}E QF . o epcq.:cont = l‘l ER S angEn Restore Defaults.., |
. BXCEpLiOns onchip_memory2_1 Bnchip_memory2_

.heap onchip_memory2_1 anchip_menory2_1

. rodata onchip_memary2_1 nchip_memory2_1

. rwdata onchip_memory2_1 nchip_memory2_1

.stack onchip_memory2_1 nchip_memory2_1

Jtext Il chin_memary2_1 chin_memory2_1 |

Linker Memory Regions

| Linker Region Name Address Range v Memory Device Name Size (bytes) | Offset (oytes) || Add... ]
epca_control Ter_0O_av]_mem Ox03E00020 - OxO3FFFFFF |epco_controller_O_av]_men 2007120 31457312 Remove

reset OxO3EOO000 - Ox0O3E0001F |epcg_controller_O_avl_men 32| 31457280 e el f
epcg_controller_O_avi_mes_BEFORE_RESET | Ox02000000 - OxO3DFFFFF |[epcg_controller_O_avl_men 31457280 Q

onchip_memory2_1 0x00030020 - Ox0003FFFF |onchip_memory2_1 65504 32 1

onchip_memory2_1_BEFORE_EXCEPTION OxO0030000 - Ox0003001F |[onchip_memory2_1 32 0! Add Memory Device. ., |

Remov ry De

Memory Usage... |

Memory Map...
Grayed out entries are automaticalky created at generate time. They are not editable or persisted in the BSP settings file.
4. Click Generate. Make sure the BSP generation is successful.
5. Click Exit to close the BSP editor.
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Application

1. In the Nios II SBT window, select File > Nios II Application to create a new application. Develop your
Nios II application. Alternatively, you can use a template for the application creation.

2. Point your application to the BSP location that you have created in the previous section.

3. Once the application development finishes, right-click on the project in Project Explorer and select
Build Project. A *.elf file is create under the project folder.

4. Next, generate the HEX file using the mem_init_generate utility. Right-click on the project in Project
Explorer and select Make Targets > Build. The Make Targets window opens as shown below.

Figure 10: Make Targets Window

Make Targets

Make Targets for: helloWorld_modified

Target Location Add...

@ mem_init_install |Remove
© mem_init_generate ——
@ heip [ ear... |

Cancel ]| Build

5. Select mem_init_generate and click Build. Make sure epcq_controller_0.hex is created under the
mem_init folder.
Programming Files Conversion

1. In the Quartus Prime software, go to File > Convert Programming Files to open the Convert
Programming File tool.
2. Under Output programming file section, set the following items:
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a. Programming file type: JTAG Indirect Configuration File (.jic)
b. Configuration device: Select according to your EPCQ type
c. Mode: Active Serial
d. File name: You may select your preferred path for the output file (.jic). By default this is generated
under your project root directory.
e. Keep the default settings for Create Memory Map File and Create config data RPD.

Figure 11: Convert Programming File Settings

Convert Programming File - /data/mmtan/epcg_prog_quad_cvsoc_modified_shiva/nios2_jtag_sys - nios2_jtag_sys
File Tools Window
Specify the input files to convert and the type of pragramming file to generate,
You can also import input file information from other files and save the conversion setup information created here for
future use
Conversion setup files
Open Conversion Setup Data.. Save Conversion Setup...
Qutput programming file
Programming file type: |]TAG Indirect Configuration File {.jic) j
Options/Boot info Configuration device: EPCQ128 _'J Mode: Active Serial _':]
File name [output_fie jic
Advanced.. I Remote/Local update difference file ”.’{- NE :I
W Create Memory Map File (Generate output_file.map)
[T Create CvP files (Generate output file pe ¢ and output file.core rbf)
™ Create config data RPD (Generate output_file_auto rpd)
Input files to convert
File/Data area Properties Start Address Add Hex Data
= Flash Loader e
SCSXFCED6 Faisle bl
= Hex Data Absolute addressing 0x01E00000 Adid File
epcq_controlfler_0 hex -
= SOF Data Page_0 0x00000000
nios2_jtag_sys sof SCSXFCOD6F31ES
wn

3. Under Input files to convert section:
a. Select Flash Loader, then Add Device to select the FPGA device that you are using. Click OK when
you are done.
b. Select SOF Data, then Add File to choose the *.sof file generated by Quartus II compilation.
c. Click on the *.sof file that you have just added. Next, select Properties and enable Compression.

d. Click on SOF Data and select Properties. The SOF Data Properties window opens. Under
Address mode for selected pages, select Start and set the start address (32-bit hexadecimal). If
using a Cyclone® V SoC development board, set the start address to 0x0 to avoid a "size exceeds
memory capacity" error.
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Figure 12: SOF Data Properties

SOF Data Properties

-
]
Qa
m
w

OO00000K
OUVBWNKRO

-

Selected pages comment: [Page_0

- Address mode for selected pages

Start

Start address (32-bit hexadecimal): |0x0

End address (32-bit hexadecimal): |OxFFFFFFFF

OK

Cancel

e. Click OK to close the window.

AN-736
2016.05.20

f. Select Add Hex Data to open the Hex Data Properties window. Select the Absolute addressing

button and browse to the HEX file location. Click OK when you are done.

Note: You may select Relative addressing if you would like to set a relative address to the reset
vector offset (0x01E00000) you configured earlier. For example, setting a start address of
0x01F00000 for the relative addressing mode changes the start address to 0x3D00000.

Altera Corporation
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Figure 13: HEX Data Properties

HEX Data Properties

Addressing mode

o :g.&bsolute addressingg

" Relative addressing

[T Set start address: |0x1F00000

OK Cancel

g. Select Generate to generate the *.jic programming file.

Configuration for EPCQ Programming

1. Ensure that the FPGA device’s Active Serial (AS) pin is routed to the EPCQ flash. This routing allows
the flash loader to load into the EPCQ flash and configure the board correctly.

2. Ifusing a Cyclone V SoC development board, ensure the MSEL pin setting on the board is configured
for AS programming.

Download

1. Open the Quartus Prime Programmer and make sure JTAG was detected under the Hardware Setup.
2. Select Auto Detect and choose the FPGA device according to your board.
3. Right-click on the selected FPGA device and select Edit > Change File. Next, select the generated *.jic

file.
4. Select the Program/ Configure check boxes for FPGA and EPCQ devices. Click Start to start
programming.
Nios Il Processor Booting From Altera Serial Flash (EPCQ) Altera Corporation

C] Send Feedback


mailto:TechDocFeedback@altera.com?subject=Feedback%20on%20Nios%20II%20Processor%20Booting%20From%20Altera%20Serial%20Flash%20(EPCQ)%20(AN-736%202016.05.20)&body=We%20appreciate%20your%20feedback.%20In%20your%20comments,%20also%20specify%20the%20page%20number%20or%20paragraph.%20Thank%20you.

AN-736
16 Reset and Boot 2016.05.20

Figure 14: Quartus Il Programmer Window When Programming EPCQ Flash on the Cyclone V SoC
Development Board

Programmer - [Chainl.cdf]* (on pg-iccf0295)

File Edit View Processing Tools Window Help & Search altera.com @

,3, Hardware Setup |USE-EIaster on pg-mmtan-440 [USB-0] Mode: ‘JTAG j Progress :

™ Enable real-time ISP te allow background programming when available

o start File Device Checksum | Usercode | Program/ | Verify | Blank- [ Examine | Security | Erase
a Configure Check Bit
it stop <none> SOCVHPS 00000000 <none> r r r r r r
Factory default enhanced SFL image S5CSXFCBDE 00C64585 00CHASBS
i Auto Detect] /data/mmtan/epcq_prog_guad_cvsoc_mmtan/mmtan/mmtan_output jic  EPCQ256 95F08185 ¥ r r r r r
<none> 5M2210Z7 00000000 <none=> r r r r r r
A Delete
(% Add File
E Change File d ‘ i
= Save File
2 Add Device
tup
L pown -
oI i
E— —k
SOCVHPS
. TDO

5. Make sure the download is successful.

Reset and Boot

1. Reset your FPGA device using the reset button or power cycle your hardware.

EPCQ HAL Driver

The Nios I hardware abstraction layer (HAL) driver has a generic application programming interface
(API) for flash devices.

This API provides you with read and write access to the EPCQ flash through the Altera Serial Flash
controller for ACDS 15.0 or later. Use driver version 15.0 (or higher) for EPCQ software application
development.

Nios Il Processor Booting Elements

Memcpy-based Nios Il Boot Copier
The Nios II processor memcpy-based boot copier has the following features:

o Supports EPCQ, CFI and Altera on-chip flash (UFM) flash memories

« Can locate software application in flash

» Unpacks and copies software application image to Random Access Memory (RAM)
« Automatically switches to application code in RAM after copy completes
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The Nios II processor boot copier is used when the Nios II soft processor application is copied from
EPCQ flash to RAM. The memcpy-based boot copier is automatically appended to the .hex file by the
Nios II SBT tool when the executable file (.elf) is converted to a memory initialization file (.hex) using the
make mem_init_gener at e target. This operation takes place whenever the .text linker section is located
in a different memory than where the reset vector points, which indicates a code copy is required. The
function of the boot copier is to copy the software application to your desired location such as RAM.
Once the copy is complete, the boot copier passes the system control to the application.

Related Information

AN 730: Nios II Processor Booting Methods in MAX 10 Devices
Refer to this information for more information about Nios II processor booting elements.

Revision History for Nios Il Booting From Altera Serial Flash (EPCQ)

I T

May 2016 2016.05.20 | Clarified notes for reset exception vector offset in the Configuration and
Compilation section.

January 2016 2016.01.19 | Clarified notes for *.sof image and exception vector found in the
Configuration and Compilation section.

May 2015 2015.05.26 | Changed .hex file size in "Nios II Processor Application Copied from
EPCQ Flash to RAM" section.

May 2015 2015.05.04 | Initial Release
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